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Introduction 
 

Thank you for purchasing Cinema Director!  Our team makes software extensions for 

Unity that allow game developers, machinima gurus, animators and film professionals 

to create and control content for their projects quickly, and easily.  More importantly, 

we want our users to have fun doing it. 

Being avid fans of video games, as well as the movie industry, we set out on a 

common goal – to create a set of cinematic game and film tools, which are powerful, 

affordable and available to the masses, through the Unity3D asset store.   

Cinema Director is the main module of our set of tools called “Cinema Suite”. Cinema 

Suite is a collection of software extensions for Unity3D that will allow developers to 

create content without the need for scripting or programming.  

It’s time to take control of Unity3D and tell your story. 

Cinema Director is a powerful timeline editing tool, 100% integrated inside the Unity3D 

game engine. Director allows the user to control almost any aspect of Unity in time, 

from particle effects and lights, to camera shots, to object placement and visibility. 

Think of it as a full in-game sequencing tool, or robust cutscene creation tool for unity. 

Now anyone with minimal knowledge of Unity3D and programming, can create 

complex scenes inside their Unity3D project. 

Please remember, making great products is only possible if we have feedback from 

people like you, and our community.  Feedback is critical to our success and we 

welcome it in all forms, be it Facebook, Twitter, Email or our Forums.  Please check out 

ways that you can directly communicate with us, at the end of this document. 

   

 

Thank you for helping us make Cinema Director great! 

The Cinema Suite Team 
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Cinema Director Overview 

Installing Cinema Director 
Cinema Director is a standard Unity3D Software Extension, and installs like any other 

Unity3D package. The name of the file we have created is called 

“CinemaDirector.unitypackage” 

 

In order to load the Cinema Director Unity3D package you either drag the Unity 

package into your current Unity3D project, or in Unity3D go to the dropdown menu: 

Assets > Import Package... > Custom Package... then browse to the 

CinemaDirector.unitypackage file. The Unity Asset Store Download Manager will 

automate this process. 

 

Figure 1: Import Package Window 

Once the Importing package dialogue appears, click the Import button. After 

approximately ten seconds, you will see a new drop down menu (Cinema Suite) under 

the window pulldown. 

 

Figure 2: Cinema Suite Menu 

Once installed, Cinema Director will appear in a folder, inside your Unity project.  
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Key Features 
 Sequence Unity objects and environment quickly and easily with no 

programming or scripting. 

 Access all the properties of your Unity3D game objects, and control their 

variables over time. 

 Set your cutscene to play in game. Sequence will play at beginning of selected 

Unity3D scenes, or at a trigger within a scene of your choice. 

 Preview or scrub through your sequence in edit mode with live time scrubbing 

tools, and make changes in real time. Includes Mecanim animation preview! 

Learning the Basics 
We have created a sample project that installs with Cinema Director called 

Director Basics. Open the Director Basics scene located in the Cinema Suite > 

Cinema Director > Example Scenes Folder. Once loaded, hit the play button in 

Unity and let Director Bot tell you all about the features of Cinema Director! 

Creating a new cutscene 
From the newly installed Cinema Suite drop down menu, you will be able to open 

the Director Window or create a new cutscene. Before the Director Window can 

be enabled, you must select create a new cutscene by selecting Window > 

Cinema Suite > Cinema Director > Create Cutscene. If you select Window > Cinema 

Suite > Cinema Director > Director, the Director 

window will open and it will be empty. If you chose to 

open the Director Window first, select the “Create” 

Pulldown at the left side of the window to create a 

new cutscene. 

Create Cutscene Window 
The create cutscene window will open. Here you 

can name your cutscene, select a duration of the 

cutscene in seconds or minutes, and select the 

number of track groups you would like to begin 

working with. We’ve also added a special I’m 

Feeling Lucky button, which adds a bit of Artificial 

Intelligence to Cinema Director. We will get into 

more detail on what the “I’m Feeling Lucky” 

button as well as tracks do later in the 

documentation.   

Figure 3: Create Button 

Figure 4: Create Cutscene Window 
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Interface Overview 
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Cinema Director is a software extension for Unity3D. 

As with any Unity window, you can position the 

application any way you wish.  Cinema Director 

shines when it can utilize more screen real estate.  

Because of this, we always recommend 2 monitors 

for use in Unity3D to enhance productivity. Let’s 

discuss each area of the Cinema Director interface 

in a bit more detail: 

Canvas (Creation Area) 

The Canvas is the user’s creation and organizational 

area, and holds all items that are used for 

sequencing in Cinema Director. The Canvas runs 

down the entire left side of the Director window.  

When creating a sequence, the Canvas will be 

populated with Containers. There are four main 

types of Containers, which are known as groups 

and represented by these icons:  

- Director Group   

- Actor Track Group     

- MultiActor Track Group. 

- Character Track Group   

These groups can hold the following information: 

 Global Tracks (Which include shot tracks, audio 

tracks and other global type tracks) 

 Actor Tracks 

 Curve Tracks and keyframes 

The Canvas also holds additional information: 

- Re-order group 

- Add Track 

- Add Actor Object 

- Increase Curve Track Size 

- Decrease Curve Track Size  

Figure 5: Canvas Area 
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Toolbar 

 

Figure 6: Cinema Director Toolbar 

The top of the director window houses the Toolbar.  There are two areas within the 

toolbar.  The create pulldown on the left side of the toolbar allows the user to 

create a new sequence (cutscene) and to add Groups. The play and stop button 

on the left side of the toolbar will start or stop the cutscene in preview mode. The 

remaining right area of the toolbar houses the time marker. The time maker shows 

the length of the sequence, and acts as a reference or guide to determine how 

many seconds a track is active for.  Clicking anywhere on the time marker will jump 

the time scrubbing tool to that exact point in time and enable Preview Mode. 

Preview mode is enabled when the Preview Mode button on the right side of the 

toolbar glows red. Functions of the toolbar are as follows: 

 

- Create a new cutscene, and Add groups (Director, Actor, 

MultiActor) 

- Target Cutscene Object in Inspector 

- Refresh Timeline Editor 

- Toggle between multiple cutscenes 

- Start and Stop cutscene in preview mode. 

- Enable/Disable Snap to Grid 

- Fit cutscene to window 

- Zoom timeline in 

- Zoom timeline out 

- Enable/Disable Preview Mode 

- Time Ruler 

Director Group 

 

Figure 7: Director Group 

The Director Group is represented by the icon and allows you to add tracks 

that will globally affect your cutscene. You can add shot tracks, that allow you to 



Cinema Director User Documentation 

 

 

sequence a set of shots (or camera cuts) based on when they are to be displayed 

in time. You can add audio tracks that allow you to add multiple audio clips to your 

cutscene.  Finally, you can add a variety of global tracks that allow you to add 

many different options such as transitions, time warping, storyboarding, and other 

utilities we will discuss later. 

Actor Track Group 

 

Figure 8: Actor Track Group 

The Actor Track Group is represented by the      icon and is used when you want 

Cinema Director to control individual Unity Objects. An Actor Track Group can hold 

either an Actor Track, or a Curve Track (shown above in Figure 8). Curve tracks can 

modify an object’s associated properties over time, and Actor Tracks can apply 

events to a Unity Object at certain points in time within your cutscene.   We will 

discuss the behaviour of curve tracks and all event options available for Actor 

Tracks later in the documentation. 

MultiActor Track Group 

 

Figure 9: MultiActor Track Group 

MultiActor Tracks are represented by the icon and allow you to control 

multiple objects in Unity at one time. For example, if you have many lights in a 

scene, you can control all of their intensity at one time instead of having to make 

an individual actor track for every object. Similar to Actor Track Groups, MultiActor 

Track Groups can hold Curve Tracks and Actor Tracks. Curve tracks will dynamically 

control a common property of all objects selected over time, and an Actor Track 

will allow you to apply events to the full group of objects. 
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Character Track Group 

 

Figure 10: Character Track Group 

Character Track Groups are represented by the icon and allow you to take 

control of humanoid characters inside your Unity Project. The characters must be 

Mecanim rigged and compatible. The Character Track group holds two types of 

tracks – Mecanim tracks and dialogue tracks. Dialogue tracks allow you to quickly 

apply 3D audio to your character for dialogue sequences, and Mecanim tracks 

allow you to apply Unity Animator commands directly to your character. 

Cutscene Duration 

 

Figure 11: Cutscene Duration Marker Highlighted 

The duration of your cutscene is represented by a vertical, cyan coloured line at 

the end of your Cinema Director project. This line will appear at the time that the 

initial cutscene has been set to when creating the project. Clicking on the 

Cutscene Duration Marker, and dragging will adjust the total duration of your 

cutscene in seconds. 
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Timeline Area 

 

Figure 12: A view of the timeline area in Cinema Director 

The timeline holds all information that is inputted into Cinema Director.  It is a 

vertical grid, broken into 5 second intervals.  The time scrubbing tool runs vertically 

along the entire length of the timeline. Resizing the Director window will increase 

and decrease the timeline scale. Hitting the    button will automatically scale the 

timeline to fix the Director window, according to the Cutscene Duration Marker. 

Clicking the   and         buttons will increase and decrease the timeline scale 

accordingly. Selecting the      button will allow you to snap Track items to the 

timeline grid that is currently displayed. As you zoom in, more gridlines will be 

displayed to snap to than if you zoom out. 

Time Scrubbing Tool 

 

Figure 13: Time scrubbing tool highlighted 

Cinema Director is a dynamic software extension, which allows the user to preview 

what they are working on in real-time, either in the Unity Scene window or Game 
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window.  The Time Scrubbing tool gives the user this control.  Clicking on the red 

Time Scubbing Marker,  and holding the mouse button while dragging, will 

move the Time Scrubbing Tool across the timeline. The Game window will show the 

sequence live as you scrub. Clicking any spot on the timeline header will 

immediately jump the time scrubbing tool to that point in time. Hitting the spacebar 

key will toggle the time scrubbing tool to play and stop, similar to other popular 

video editing programs.  When you click on the timeline header or scrub the Time 

Scrubbing tool, notice that the    button will activate. To exit preview 

mode, press the stop button  or hit the red preview mode button. 

Curve Tracks 

 

Figure 14: Curve Track showing multiple Curve Clips 

After creating an Actor Track Group or MultiActor Track Group, Cinema Director 

provides the option to create a Curve Track. Curve tracks will look at all available 

properties for the Unity Object that has been applied to the Actor or MultiActor 

Track Group, and allow curve clips to be created based on one of these 

properties. The curve editor will then control the selected property dynamically 

over time. Depending on the property selected, you will either be able to edit a 

single curve, or edit multiple curves representing the X, Y, Z axis of an object if you 

are tracking transformation values. The example above shows two curve clips – one 

set to track position transform and one set to track rotation transform.  

Actor Tracks: 

 

Figure 15: Example of Multiple Events in Actor Tracks 

Actor tracks hold track events (shown above in Figure 15) that can be applied to a 

Unity Object that has been assigned to an Actor or MultiActor Track Group. These 

events are then triggered at the exact moment in time that they are applied to on 

the Timeline. Cinema Director has an extensive events library, which allows you to 

apply events such as triggering animations, audio, enabling and disabling game 

objects, applying physics and more. 
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Curves and Keyframes 

 

Figure 16: Actor Track Group showing Curve Track 

When a curve track is expanded in a Director Group, Actor Track Group or 

MultiActor Track Group, curves will display. These curves represent how the 

associated Unity Game Object is being tracked in Cinema Director. Manipulating 

the Game Object inside of the Unity Scene will automatically adjust the curves, and 

will be reflected in Cinema Director, as long as Cinema Director is in Preview Mode. 

Keyframes will automatically be generated as well, at the exact point 

the time scrubbing tool is located when the GameObject is manipulated in the 

Unity Scene.  The user can also manually manipulate curves and keyframes inside 

the curve track, in the Director Window.  This will be covered later in this 

documentation. 
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Using Cinema Director 

Tutorial - Creating and working with Cutscenes 
We will be using Unity’s Robot Labs Project for the purpose of this tutorial. To follow 

along, download the project from the Unity Asset Store (it’s free) and open the 

RobotLab scene. 

Opening the Create Cutscene Window 

From the newly installed Cinema Suite menu under Window, you will be able to 

open the Director Window or Create Cutscene. You can use Ctrl+Shift+D as a 

shortcut to open the Director Window as well. 

 

Figure 17: Cinema Director Menu 

If you already have your Director Window open, 

you can also open the Create Cutscene Window 

by pressing the      pulldown inside the 

Director Window and choosing “New Cutscene”. 

Creating a new Cutscene 

When you select Create Cutscene from the 

Unity menu, the Create Cutscene window will 

open. This window will display many options to 

get started as efficiently as possible on your 

new project.  

You can create a new cutscene using two 

options. First is manual configuration by 

adjusting the given values and selecting the 

Create Cutscene button. Second is by using 

the I’m Feeling Lucky button.  

Manually creating a cutscene involves giving 

your cutscene a name. After it is named, Figure 18: Create Cutscene Window 
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select a duration for your cutscene. When selecting a duration you can select 

between seconds and minutes. After your cutscene duration is selected, you can 

then check if you would like to loop your cutscene (have it play over and over) by 

selecting the looping checkbox. If you would like your cutscene to end on either a 

gamepad movement or by a keyboard command, select the skippable option as 

well. 

Creating Groups and Tracks 

The Track Groups area allows Cinema Director to automatically generate the 

number of initial tracks you would like to use in your project. Since you can only 

have up to one Director Group, your options are one, or zero. Select if you would 

like an initial Shot Track, up to four initial Audio Tracks, and up to ten Global Tracks. 

You can also sign up to ten Actor Track, MultiActor Track or Character Track 

Groups. 

The Actor Track Groups area allows you to select how many initial Actor Track 

Groups you would like in your scene. When you select a number between zero and 

ten, that amount of Actor Track fields will appear below the Actor Track Group 

area. Here, you can select what Unity Object you would like to set as an actor. 

Click the target button to the right of the field, and Unity will display all Unity 

Objects available in your current scene. For each field, select an object that you 

would like a new Actor Track Group created for and it will be created.  

 

Figure 19: New Cutscene using Create Cutscene Settings 
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Selecting and Configuring a Start Method 

Start Method allows you to select how you would like 

your cutscene to start. Selecting On Start will start the 

cutscene immediately when you enter Play Mode in 

Unity. Selecting On Trigger will start the cutscene when a 

Game Object in Unity of your choice hits an assigned 

box collider. This allows for in-game sequencing. 

Once your cutscene is created, a Cutscene 

Trigger Game Object will be created in your Unity 

Scene.  

Clicking this game object and working in the Unity 

Inspector will allow you to: 

 Select the Start Method – Choices are OnStart or OnTrigger.  

 Select which cutscene to trigger (if you have multiple cutscenes).  

 Select the Trigger Object, which is the Unity Game Object that will interact 

with the Box Collider that has been created in the scene for the trigger 

mechanism. 

 Enter the Skip Button Name, which will skip the cutscene on an assigned 

command that is setup under the Input area of the Unity Project Settings 

 

Figure 22: Cutscene Set to start On Trigger 

Figure 20: Selecting a Start 

Method 

Figure 21: Cutscene Trigger Settings 
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Figure 22 shows how settings would look for configuring a cutscene “OnTrigger”. In 

this example, the cutscene will start when the game character (Astrella) is moved 

into the box collider on the right. 

Using the I’m Feeling Lucky Button 

Another option is to use the I’m Feeling Lucky button. This button uses artificial 

intelligence to analyse your current Unity scene and automatically pre-select Unity 

Objects that it deems may be relevant to creating a cutscene. Those objects are 

automatically populated to the Actor Track Groups you have selected. For 

example, if you select four Actor Track Groups, the I’m Feeling Lucky button will 

select four Unity objects. We will improve this functionality in future versions of 

Cinema Director, and plan on adding even more AI to the software, so stay tuned! 

Figure 19 shows the cutscene that has been created for the settings shown in Figure 

18 above. We will continue to use these settings to show the functionality of 

Cinema Director. 

Selecting Between Multiple Cutscenes 

Cinema Director allows you to have as many 

cutscenes in your Unity Scene as you like. You can 

toggle between cutscenes using the pulldown in 

the Cinema Director window that displays your 

cutscene name.  

Reordering Groups 

If you do not like the order that Groups or Tracks have been populated in, you can 

re-order them at any time. Simply select either the up or down arrow beside 

the Group or Track you would like to move, and it will re-order accordingly. 

Cutscenes in the Unity Inspector 

Unity will store all information about 

your cutscene in the Hierarchy as game 

objects within the current scene. When 

you select the cutscene in the 

Hierarchy tree, information about all of 

the cutscene’s properties will be 

displayed in the Unity Inspector. If you 

are an advanced Unity User, many 

Figure 23: Cutscene Selection 

Figure 24: Unity Inspector Cutscene View 
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of the options can be set here, instead of in the Director Window. Think of the 

Director Window as a visual editor to the game objects that are associated to the 

cutscene in the Unity Inspector. Changes you make in the Unity Inspector will reflect 

in the Director Window, and vice versa. The remainder of this documentation will 

only cover cutscene creation using the Director Window, and we will touch on 

changing options in the Unity Inspector as required. 

Working with Groups 
As mentioned in the Director Overview section of this 

document, there are 3 types of groups you can 

create in Cinema Director. To create a group, simply 

click the Create pulldown in the Director Window 

and select the group type you want to add. Let’s 

add a new Director Group. 

Creating Director Groups 

The Director Group is represented by this icon . 

Starting with an empty cutscene, adding a Director 

Group will display as shown in Figure 26 (Side). As 

discussed earlier, Director Groups control tracks that 

globally effect the scene. There are three types of 

tracks that can be added – Shot Tracks, Audio Tracks and Global Tracks. To add 

one of these tracks, click the red plus icon located beside the Director Group 

name, you will then be presented with the option to add one of these tracks. Let’s 

add a shot track. 

Shot Tracks 

The shot track will allow you to set up cameras in 

your cutscene that will change shots over time. To 

add a shot track, click the red plus located beside 

the Director Group name and chose “Shot Track” 

from the pull-down menu. A new track will appear in 

your timeline, with the same red plus icon beside the name. Clicking the red 

plus will add a Shot to your timeline of five (5) seconds in length as shown in Figure 

27 and the red plus sign will turn green . Events such as this placed on the 

timeline are known as Track Items. Notice that the Shot created in the timeline is 

red. This means that there is no camera assigned to the shot as of yet. 

Figure 25: Adding Groups 

Figure 26: Empty Director Group 

Figure 27: New Shot in Director 
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Adding a Camera 

To add a camera, right click on the newly created 

Shot in the timeline. You will be able to select “Set 

Camera” from the pull down menu. When you select 

this, Cinema Director will look for any active cameras 

in your scene and allow you to select them. We will 

chose “Establishing Cam”, which is a camera we 

previously created in our scene. Once the camera is selected, the Shot Camera 

icon in the timeline will from red to blue. 

Focusing and Deleting Shots 

If you would like to see how the chosen camera associated to 

the newly created shot is aligned, right click on the shot once 

again, and select “Focus”. You will notice that your scene view 

in Unity will now reflect what the camera is looking at. 

If you would like to remove the shot, right click on the shot and select “Delete”. You 

can also remove the shot from the timeline by highlighting the shot with your 

mouse, and hitting the delete key on the keyboard. 

Adding additional Shots 

Selecting the green plus icon will add a 

second shot to your timeline. Right click on 

the shot, and add a second camera. For our 

example, we are going to select the “Far Door 

Cam” in our project. A second shot of five 

seconds long will be added, and will also be named “Shot”. As you build shots, it 

may start to become difficult to keep track of things. Cinema Director is fully 

customizable, and allows you to rename anything that you create. 

Renaming Shot Items 

To rename a shot in Cinema Director, 

right-click the shot item and select 

“Rename” from the context menu. You 

can also rename by selecting the shot, 

and renaming the game object in the 

Unity Inspector.  

Figure 28: Attaching a camera 

Figure 30: Multiple Shots 

Figure 31: Renaming Track Items 

Figure 29: Say Cheese! 
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NOTE: ALL track items in Cinema Director can be renamed using this method. 

Moving and resizing Track Items 

Shot Track Items like we just created, and any other track items 

that run over a period of time can be moved and resized. To 

move a track item, hover your mouse over that item. You will 

see your mouse cursor change to have small arrows added on each side. Click 

and hold then move the track item to the new desired location. If you have snap 

enabled in the Cinema Director toolbar, the time of the track item will snap to the 

grid accordingly. 

To resize a Track Item, hover your mouse over the left or right 

edge of the track item. Once the double arrow icon appears, 

drag to the left or right. This will make the track item longer or shorter. The snap 

setting also applies for resizing track items, if you have it enabled. 

Previewing Shots 

 

Figure 32: Shot Preview in Game Window 

Once you have your shots created, you can then use the scrub time tool or the 

play button on the Cinema Director toolbar to preview what your camera shots 

look like in Cinema Director. Click and hold on the time scrub marker and drag left 

or right to see your shots reflect in the Unity Game Window. If you want to view as 

per real time, hit the spacebar, or hit the play button  on the Cinema Director 

toolbar as shown in Figure 32. Notice the additional information available to you 

when expanding the shot track. 
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Audio Tracks 

Cinema Director makes adding audio to your scene 

quick and easy. We will add some background music 

to our cutscene by clicking on the green plus icon 

beside the Director Group and selecting “Add Audio 

Track”. You will see a new track created under your 

director group called “Audio Track”. Again, if you 

would like to change the name of the track, right-click 

the track name, then rename the Game Object. We 

will rename our track “Background Music”.  

Assigning Audio 

To add the audio clip that you would like to apply to the 

track, click the red plus icon beside the track name. 

Cinema Director will then display all available audio in 

your Unity Project, and allow you to select a clip.  

Once the clip is selected, it will be applied to the audio 

track on the Timeline. You can then move or resize the 

track event that has been created in the exact same 

way as shot tracks, described above. Audio track 

events will appear orange in the timeline. Resizing the audio track event will clip the 

audio at its in or out point. You can have as many audio track events on a single 

audio track as you want, as 

long as there is sufficient space 

available on the track. 

Expanding the Audio track will 

show the audio’s wave 

pattern. 

Figure 35: Audio Clip Selection 

Figure 33: Adding Audio 

Figure 34: Audio Tracks in Cinema Director 
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Multiple Audio Clips 

To add another audio clip to the same track, click 

the green plus button (that was once red) and 

follow the same process above in Figure 33. Cinema 

Director also allows you to have as many Audio 

Tracks as you wish. To add a second audio track, 

follow the same steps above by clicking on the 

green plus sign beside Director Group, and selecting 

“Add Audio Track”. A new Audio Track will appear, 

and you can now assign new audio clips as 

described above.  

Figure 34 shows an example of multiple audio clips 

created on a single Audio Track, as well as multiple 

Audio Tracks, inside the Cinema Director Window. 

When you hit the play button, scrub the timeline 

using the time scrubbing tool or hit play in game, the 

new audio will play. If you are using multiple audio 

tracks, all of the audio will play simultaneously, 

allowing you a great way to mix audio. 

Adjusting Audio 

Cinema Director makes it very easy to adjust audio after it has been added to the 

timeline. Selecting the Audio Track Item will display all of the audio’s properties in 

the Unity Inspector. Here you can change settings such as the Audio Clip’s name, 

Bypass effects, priority, volume, pitch, 2D and 3D sound settings, and more.  

Global Tracks 

Global Tracks contain additional events that are 

applied globally to your Cinema Director Cutscene. 

They control an extensive event library that can help 

you add additional effects to your cutscene, or 

provide useful tools. Events created with Global Tracks 

can range from transitions, to creating storyboard 

images of your cutscene. For a full list of possible 

Global Track events, see Appendix A at the end of 

this document.  

Figure 36: Audio Settings 

Figure 37: Adding Global Tracks 
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Creating a Global Track 

Creating a Global Track is no different than creating a 

shot track or audio track. Click the green plus icon 

beside the Director Group, and select “Add 

Global Track”. Once your track is added, you can 

rename it using the previous methods mentioned 

above.  

Assigning Global Track Events 

To add a Global Track Event that you would like to 

apply to the track, click the red plus icon  beside the track name. Cinema 

Director will then display the menu with flyouts shown in Figure 38.  

For the purpose of this tutorial we are going to add two different event types – a 

Transition (Fade from Black) and a Utility (Storyboard). Transitions create events 

similar to Shot or Audio Tracks that last over a certain period of time. Storyboard 

creates a trigger, which is an event that initializes exactly at a certain point in time.  

Working with Global Events over Time 

To add a Fade from Black transition, select 

Transitions > Fade from Black. A new track event 

will appear in the Global Track, called Fade from 

Black. To rename the event, either right-click the 

event, or rename the Game Object in the Unity 

Inspector after selecting the event. 

You can then move or resize the Global Track 

event that has been created in the exact same 

way as shot and audio tracks, described above. 

Global Track Events will appear pink colour in the 

timeline. Resizing the global track event will 

adjust how much time the event will take to 

complete. Figure 40 shows how a Global Track 

that operates over time looks in the Cinema Director Timeline. 

Working with Global Events Triggers 

Next we will add a storyboard event, to demonstrate how triggered events work. 

Click the green plus sign beside the Global Track and select Utility > 

Figure 38: Global Track Event Menu 

Figure 39: Adding Transitions 

Figure 40: Global Track Event Over Time 
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Storyboard. A large keyframe marker  will appear on the timeline which is 

followed by the name of the event you selected. Clicking on the keyframe marker 

will display the Global Event Track Game Object in the Unity Inspector, where you 

can change the name of the event if you wish. The Storyboard event will create a 

screenshot of your cutscene, and place it in the Assets > Storyboard folder of your 

existing Unity Project. For a detailed explanation of how Global Track Events work, 

see Appendix A at the end of this documentation. 

Global Events that are triggers cannot be resized, but they can be moved along 

the timeline by clicking and then dragging the event to a new desired location. 

 

Figure 41: Complete Director Group & Timeline 

Figure 41 shows our complete Director Group with the Global Track and Global 

Track Items renamed. You can have as many Global Track Events on a single 

global track as you want, as long as there is sufficient space available on the track. 

Cinema Director allows you to create as many Global Tracks and Global Track 

Events as you wish. 

Hitting play in the Cinema Director toolbar, or clicking and dragging the time 

scrubbing tool, will preview your Global Track events in the Unity Game Window. 

Certain Global Track Events cannot be previewed. To learn about all of the Global 

Track Events available, what they do, and if they can be previewed with Cinema 

Director, see Appendix A at the end of this documentation. 
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Creating Actor Track Groups 

Actor Track Groups are represented by the icon. 

Starting with an empty cutscene, add an Actor Track 

Group by clicking on the Create pulldown in the 

Cinema Director Window and selecting Actor Track 

Group from the fly-out menu. Adding an Actor Track 

Group will display as shown in Figure 42 (Side). As 

discussed earlier, Actor Track Groups control 

individual Game Objects inside your Unity scene. 

There are two types of tracks that can be added – 

Actor Tracks and Curve Tracks. To add one of these 

tracks, click the red plus icon located beside the 

Actor Track Group name, you will then be presented 

with the option to add one of these tracks. 

Selecting a Game Object 

Before deciding which track you will add, you should first 

select a Game Object in Unity that the Actor Track Group will 

control. To do this, click the red target icon located 

beside the Actor Track Group Name. The target is red when 

no Game Object has yet been associated with the Actor 

Track Group. Note: You CANNOT select a game object if the 

timeline is in preview mode. In this example, we want to 

control movement of one of our cameras.  Clicking the target 

icon will open a Unity Selection Window, where you can 

search for, and select the Unity Game Object you want to 

control. For this example, we are going to select the 

Establishing Cam Game Object as shown in Figure 43. Once 

selected, the target button will turn green. 

Creating a Curve Track 

Clicking the red plus sign will allow you to add either an 

Actor Track or a Curve Track to the timeline. Curve tracks 

allow you to dynamically manipulate the properties of an 

object over time by using curves and keyframes. We are 

going to add a curve track to control the movement of 

the Establishing Cam. 

Figure 42: Adding an Actor Track 

Group 

Figure 43: Game Object 

Selection 

Figure 44: Adding Curve Tracks 
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Adding a Curve Track will display the new track on the timeline. Click the Expand 

arrow to the left of the Curve Track name. Notice that the curve 

track, at this point is empty. To proceed, we need to add a Curve Clip. 

Adding Curve Clips 

A curve track can hold many Curve 

Clips. These are events that control 

the movement of the Game Object 

that has been assigned to the Actor 

Track Group. If you would like to 

manipulate the Game Object 

multiple times over the course of the cutscene, you would create additional Curve 

Clips to do so. 

To add a Curve Clip, click the red plus icon on the newly created Curve Track. 

Once you do so, the plus will turn green, and you will see a new Curve Clip 

populate inside the Curve Track. The clip can then be resized and moved using the 

same methods of any other event type in Cinema Director. 

Selecting a Curve Type 

When you create the curve clip, it will be empty and 

waiting to be assigned a component to track. Right click 

on the Curve Clip and select Add Curve. Selecting Add 

Curve will display a fly-out menu which will allow you to 

select a component to track. The components listed will 

be read from the Game Object that has been selected 

and applied to the Actor Track Group. Once the component is selected, you can 

then select the property of that component you want the curve editor to control by 

selecting it from the fly-out list. 

Working with Transform Curves 

Since we are selecting a Camera Object, components only valid to this Game 

Object Type will be visible. For this example, we are going to track the Transform 

component. When you 

select a Component, 

you can then select a 

property that is valid for 

that Component. Since 

Figure 46: Adding a Curve 

Figure 47: Setting Curve Type 

Figure 45: Empty Curve Clip 
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we want to move the Establishing Cam over time, we will select Position.  

Because we selected the transform option, 

three curves will display, each for the X, Y, and Z 

axis in Unity. To modify the curves, select the 

Curve Clip you would like to edit from the 

pulldown in the curve track area. Then, select 

the Edit button. This will display keyframes that 

you can then use to modify your curves. Since 

we only have one Curve Clip, only that Curve 

Clip will appear in the edit pulldown menu. If you 

want to edit multiple Curve clips on the same track, simply select the Curve Clip 

you want to edit from the edit pulldown and then click the edit button, as shown in 

Figure 48. 

Working with Master Keyframes 

  

Eight Keyframes are automatically generated when the curve is edited. The top 

right and left keyframe are known as Master keyframes, and control the length of 

the curve. The overall length of the curve is constrained by the overall length of the 

Curve Clip Event. Clicking and dragging either of these Keyframes will extend or 

contract all curves at once. To extend the time of the curve event, simply hover 

over the edge of the curve clip and drag. In Figure 49, we have adjusted the curve 

track’s length to match the length of the Establish shot track by clicking and 

holding the right edge of the Curve Clip Event and dragging to the right.  

Figure 49: Keyframes in Curve Tracks 

Figure 48: Editing Curves 



Cinema Director User Documentation 

 

 

Working with Curve Keyframes 

Curve Keyframes control each curve independently 

of the other. By clicking and dragging a Curve 

Keyframe, you will adjust the intensity of the curve. 

This will control the Game Object that is assigned to 

the Actor Track Group over time. If you want 

additional precision and control of a curve, you can right click on a curve and 

select Add Keyframe. This will place a set of keyframes exactly at the point on the 

curve that you clicked. You can then move all keyframes created by clicking and 

dragging the Master keyframe at the top, or individually control the curve by 

clicking and dragging one of the individual keyframes. To add further control, you 

can move the time scrubbing tool directly to a keyframe by right clicking on a 

master keyframe and selecting Snap Scrubber. 

 

 

 

 

 

 

 

 

 

 

Figure 51 shows how we have selected the end curve keyframes, and adjusted the 

camera movement. When you click and drag keyframes, you will immediately see 

the change take place in your game window. Notice how the camera now pans in 

towards the center of the scene after adjusting the three curves individually. 

Figure 50: Adding Keyframes 

Figure 51: Keyframes set to move camera object 
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Using Game Objects to Create Keyframes 

One great feature of Cinema Director, is that you can create keyframes on your 

curve track by selecting the Game Object in your Unity scene and moving it using 

the Unity Transform controls, either in the scene window or in the Inspector.  

 

Figure 52: Creating Keyframes by Transforming Game Objects 

To do this, move your time scrubbing tool to where you want the keyframes 

created. This will put Cinema Director into Preview Mode. Then, select your game 

object in the Unity scene, and manipulate its X, Y and Z transform values. You will 

notice that the curves update to reflect exactly where you are moving the game 

object. This is a great visual aid, to make sure that objects behave exactly as 

intended when building your cutscene.  

Figure 52 shows how we have moved the Establishing Cam Game Object closer to 

the character in the Unity Scene Window. Notice the visual update in the Game 

Window, as well as the keyframes being created in the curve track. Also, the curves 

themselves dynamically update to reflect the Game Object’s Movement. 
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Using Keyframe Grips to Modify a Curve 

When you select a keyframe, you can click and drag 

to move in any direction. However, Keyframe Tangent 

Grips also appear when you select a keyframe, and 

allow you to further refine the curve. Clicking the grip 

point and dragging, will modify the curve in relation to 

the grip’s tangent. 

Keyframe Tangent Grip Types 

Right clicking on a keyframe will display many different 

options that you can use to manipulate a curve in fine 

detail. Auto, Free Smooth, Flat and Broken affect how 

the Keyframe Tangent Grips behave. 

Auto – Disables Keyframe Tanget Grips and takes a 

best guess on adjusting the curve when moving the 

keyframe. 

Free Smooth – Selecting either the left or right Tangent 

Grip will manipulate the entire curve at once. 

Flat – Returns the Keyframe Tanget Grip to a linear (flat) 

position. 

Broken – Breaks the curve at the Keyframe, and allows 

individual adjustment of the left and right Keyframe 

Tangent Grip, affecting the left and right segment of 

the curve accordingly. 

Clicking and dragging a Keyframe Tanget Grip will 

manipulate your curve. Dragging the mouse farther away from the grip will give 

you more precise control over the curve’s adjustment. 

Advanced Curve Control 

Cinema Director allows the ability to change the type of curve that is created, by 

modifying how the Keyframe Tangent Grip affects the curve. This allows for even 

further control of how curves are created. When you right click on a keyframe, you 

can select how either the right tangent, left tangent or both tangents control the 

selected keyframe (Figure 54). 

Figure 55: Keyframe Tangent 

Grip Options 

Figure 53: Keyframe Grips 

Figure 54: Keyframe Editing 
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Linear – The curve segment will become a straight 

line between the neighbouring keyframe. A linear 

curve segment can be made by setting the 

tangents at both ends to be Linear. 

Constant – The curve retains a constant value 

between two keyframes. The value of the left key 

determines the value of the curve segment. 

Free – Similar to above, free will automatically break 

the keyframe, and allow for manipulation of the left 

and right Keyframe Tangent Grips, independent of 

each other. 

Controlling Curves with Numeric Input 

 It is possible to manually enter values for a keyframe, if exact precision is required. 

To enter a value for a keyframe, select the master keyframe, right click and select 

“Snap scrubber” This will snap the time 

scrubbing tool to your keyframe. Then, in 

the canvas area, enter a new number for 

the desired keyframe. In Figure 57, we are 

modifying the Z curve to have a value of 

1.5 at the selected keyframe.  

It is also possible to create new keyframes 

using an assigned value. Move the time 

scrubbing tool to the location that you 

would like the new keyframe, then, click on 

the keyframe icon in the curve track 

canvas. Select “Add Key” and then assign 

a new value. In Figure 57, we are adding a 

new key to the Z curve and assigning a 

value of 1. 

  

Figure 56: Curve Types 

Figure 57: Controlling Keyframes Numerically 
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Adding Additional Curves to a Curve Clip 

It is possible to track more than one 

transformation type in a curve clip. To add 

an additional set of curves, right click on the 

curve click in your curve track, and repeat 

the process for adding a curve to the curve 

clip. Once the curve is added, you will now 

see those curves available for keyframing, 

complete with their own colour set. The new 

curve’s properties will be added to the 

canvas area as shown in Figure 58. 

Controlling Visibility of Curves 

When doing complex work, many curves in a single curve clip can become 

confusing and distracting. With Cinema Director, you can control the visibility of 

curves. You can either make individual curves invisible, or make the entire curve set 

invisible. 

To make the entire curve set invisible, select the white keyframe icon beside the 

curve set name, in the Cinema Director 

canvas, and select “Visible” as shown in 

Figure 59. To make the curve set re-appear, 

once again select the white keyframe icon, 

and select “Visible”. 

To make an individual curve invisible, the 

process is the same as above, except you 

select the coloured keyframe icon beside 

the curve that you would like to control. 

Figure 59 shows us making the Z curve for 

Position invisible.   

Figure 58: Adding Additional Curves 

Figure 59: Curve Visibility 
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Deleting Keyframes 

In Figure 60, we demonstrate the effect of 

deleting Master keyframes, and deleting 

individual keyframes. Right clicking on any 

master keyframe and selecting Delete 

Keyframes will remove all individual 

keyframes at one time, If you want to 

delete the portion of only one curve, right 

click an individual keyframe and select 

Delete Key. 

Creating an Actor Track 

Actor tracks are identical to Global Tracks in how they 

behave. However, Actor tracks will only affect the Game 

Object that has been assigned to the Actor Track Group. 

Actor tracks work well when you want to trigger an event to 

happen to a Game Object at an exact moment. Cinema 

Director contains a very extensive events library for Actor Tracks, 

including Legacy and Mecanim Animators, Physics, Enabling and 

Disabling Game Objects, and more. For a full list of Actor Track 

Events and a description of what they do, see Appendix A.  

Creating an Actor Track is identical to creating other track types. 

For this example, we will create a second Actor Track Group and 

assign an object in the scene that we can apply events to. To 

create a new Actor Track Group, follow Creating 

Actor Track Groups above. 

For this example, we are going to assign the 

“char_astrella” Game Object to our new Actor 

Track Group using the red target icon . Once applied, click the red plus icon 

and select Add Actor Track. 

  

Figure 60: Deleting Keyframes 

Figure 61: Adding Actor Tracks 
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Creating an Actor Track Event 

Almost all events that can be applied to a 

Game Object using an Actor Track are 

triggers. In this example, we are going to 

disable a Game Object, to make the 

object disappear when the cutscene hits 

that moment in time. To do this, select the 

red plus icon beside the Actor Track 

name and select Game Object > Disable from the flyout menu. Once selected, a 

new, large keyframe will appear on the Actor Track called “Disable”. 

 

Figure 63: Disabling a Game Object 

We would like the Astrella character to disappear as soon as the camera zooms in 

on her. To do this, click the Actor Track Event called “Disable” and drag it to a 

position on the timeline that closely matches the end of the Establish Cam shot. 

Remember, you can always right-click on the actor track to change the name, or 

you can rename the Actor Track Event in the Inspector when you click on it. See 

Figure 63 above. 

  

Figure 62: Adding Actor Track Events 
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Creating MultiActor Track Groups 

MultiActor Track Groups are represented by the 

icon, and work almost the same way as Actor 

Track Groups, the difference being that they allow 

you to control multiple game objects at one time. 

Very useful when applying physics events or 

controlling lighting in your Unity Scene. To create a 

MultiActor Track Group, under the Groups pulldown select Add > MultiActor Track 

Group. As with Actor Tracks, MultiActor tracks contain both Curve Tracks and Actor 

Tracks. We will now select the Game Objects we want to control, and assign them 

to a Curve Track. 

Assigning Game Objects to MultiActor Track Group 

To assign the multiple Game Objects you would like 

to control, you must access the Unity Inspector. To 

do this, click the MultiActor Track Group name. In 

the Unity Inspector, you will select the number of 

Game Objects (known as Elements to Unity) you 

would like to control. To do this, change the 

number beside the Actors > Size field from 0 to your 

desired number. For this example, we are going to 

select six actors, which will be Unity Light Game 

Objects that we are going to control with a curve 

track. Figure 65 shows the Game Objects we have 

selected from the scene, by clicking on the target 

button beside each element number and selecting the Game Object from the 

Unity Selection Dialogue box. You can also select elements by dragging and 

dropping Objects from the scene Hierarchy to the Element selection box. We have 

renamed the MultiActor Track Group “Control Lighting”. 

  

Figure 64: Adding MultiActor Track 

Group 

Figure 65: Assigning Actors for 

MultiActor Track Group 
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Creating MultiActor Curve Tracks 

Click the red plus icon beside the 

MultiActor Track Group name. You will then be 

given the choice to create either a Curve 

Track or an Actor Track. Selecting a Curve 

Track will add an empty curve track. Click the 

red plus icon in the new curve track to create 

a new Curve Clip. For this example, we will 

select a Float curve type, which is the same as 

saying “value”. To set the MultiActor Curve Clip 

type, select the curve clip event, and then 

change the Property Type in the Unity Inspector 

to Float. We are choosing this curve type 

because we will be controlling the intensity 

property of the lights we have selected.  

For a complete list of Unity curves and how they 

behave, see their official documentation at: 

http://docs.unity3d.com/430/Documentation/Manual/UsingAnimCurves.html 

Configuring MultiActor Curve Tracks 

Once the curve type has been selected, once 

again select the new Curve Clip. This will display 

configuration options available in the Unity 

Inspector. This will allow you to individually control 

each Unity Game Object. 

Component allows you to select if you want to 

either transform (move) the Game Object with the 

curve track, or have the curve track modify a 

specific Game Object property.  

Property will expose all available properties that you 

can configure for the selected Game Object.  

In Figure 68 we have selected Light as the component, and will be modifying the 

“Intensity” property, so that the lights brighten and dim over time.  

Figure 66: Adding Curve Tracks 

Figure 68: Selecting Properties for 

Curve Track 

Figure 67: Set MultiActor Curve Type 

http://docs.unity3d.com/430/Documentation/Manual/UsingAnimCurves.html
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Modifying MultiActor Curve Tracks 

Once your curve is created, you can use the same methods described above in 

Creating a Curve Track to resize your curve, as well as add, modify and delete 

keyframes, etc. Figure 69 shows the effect of the MultiActor Curve Track controlling 

light intensity over time. Since the curve is managing multiple game objects at one 

time, the overall effect of the lighting in the scene is quite dramatic. 

 

Figure 69: MultiActor Curve Track Controlling Light Intensity 

Creating MultiActor, Actor Tracks 

Actor Tracks for MultiActor Track Groups behave in the 

same way as they do for Actor Track Groups, 

difference being is that these tracks control multiple 

Game Objects at one time. For this example we 

are creating a second MultiActor Track Group, and 

configuring it as shown in Figure 70. We have 

selected four boxes that we have copied and 

moved in front of the Astrella Character. We have 

assigned those Game Objects to the new 

MultiActor Track Group and renamed the group 

“Control Boxes”. We will then add a new Actor 

Track, and apply a physics force to all the boxes at 

one time. 
Figure 70: Control Box Actor Track Group 

Configuration 
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To add a MultiActor Track Group Track, click the red plus icon to the right of 

the MultiActor Track Group name and select Add Actor Track. Once the new Actor 

Track is created, you can then add an event 

to the track the same way you would for 

single Actor Tracks. To assign an event, click 

the red plus icon to the right of the newly 

created Actor Track’s name.  You will receive 

the exact same list of events available as you 

would configuring a single Actor Track. For a 

full list of events and a description of how they 

work, see Appendix A. 

For this example, we are going to select 

Physics as our event type, and then select 

Apply Force. This should get our boxes moving 

quite nicely. 

NOTE: In order for physics to work on a game object in Unity, you must make sure 

that the game object has a Rigidbody component attached to it. 

Configuring MultiActor Track Event 

Whenever you select an event to be triggered, 

you should open the event in the Unity Inspector 

so that you can adjust the event’s settings. In the 

case of the Apply Force event, we can adjust the 

type of force, as well as how much force is 

applied to the X, Y and Z axis. To do this, click on 

the newly created event, and change the 

settings in the Unity Inspector. For this example, we are setting the Force Mode to 

“Impulse, and applying a Force of 20 units to the X-Axis, 200 units to the Y-Axis, and 

30 units to the Z-Axis. We have renamed the Track Event “Box Force”. See Figure 72. 

Figure 71: Adding Actor Tracks and Applying 

an Event 

Figure 72: Configuring MultiActor Track 

Event 
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Figure 73: Example of the Apply Force Event being applied to multiple Game Objects 

Figure 73 shows the effects of using the Apply Force event on multiple game 

objects. Physics events cannot be previewed in Cinema Director, and will only 

show when you run Unity in game mode. Notice in picture 2, the boxes flying into 

the air. 

Creating Character Track Groups 

Character Track Groups are represented by the 

icon, and work in a similar manner to Director Track 

Groups, the difference being that they allow you to 

control Mecanim animations and audio dialogue for 

humanoid avatars inside of your Unity project. To 

effectively use the Mecanim track inside of the 

Character Track group, it helps to have a good 

understanding of Mecanim for Unity and how to 

manage and create Animator Controllers. To familiarize yourself with Mecanim, see 

this Unity tutorial: 

https://www.youtube.com/watch?v=Xx21y9eJq1U 

Two default tracks will be generated when you create a Character Track Group, 

they are Mecanim Track and Dialogue Track. 

Figure 74: Adding MultiActor Track 

Group 

https://www.youtube.com/watch?v=Xx21y9eJq1U
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Selecting a Game Object 

Before working with the Mecanim and Dialogue tracks, you 

should first select a Game Object in Unity that the Character 

Track Group will control. To do this, click the red target icon 

located beside the Actor Track Group Name. The target 

is red when no Game Object has yet been associated with 

the Character Track Group. In this example, we want to 

control the movements of the Astrella avatar.  Clicking the 

target icon will open a Unity Selection Window, where you 

can search for, and select the Unity Game Object you want 

to control. For this example, we are going to select the 

“char_astrella” Game Object as shown in Figure 43. Once 

selected, the target button will turn green.  

Working with Mecanim Tracks 

When you assign an avatar to a Character Group, you need to make sure that the 

avatar is bring controlled by an Animator Controller in Unity. For this example, we 

created a simple animator controller called “Astrella”. We have created two states 

called Idle and Run as shown in Figure 76. 

 

Figure 76:Animator Window in Unity 

In order to preview Mecanim animations with Cinema Director, you MUST be on 

version 4.5.3 of Unity or above. Earlier versions do not support this feature.  

Figure 75: Game Object 

Selection 
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To trigger a your avatar to perform a Mecanim 

animation (after your animator controller is 

setup) it’s as simple as clicking the red plus sign 

inside the Mecanim track and selecting 

the event you wish to perform. In this example 

we will select “Play Mecanim Animation”. 

Once selected, an event keyframe will appear 

in the Mecanim track inside the timeline and 

the red plus sign will turn green. You can 

add as many events as you wish to the 

Mecanim track by continuing to press the 

green plus sign and assigning additional 

events. Remember, you can always rename 

the event by clicking on the event in the 

timeline then changing the name in the Unity 

Inspector. 

In order for the Mecanim animation to play 

through the event, you must enter the state 

name that the animation is located in, inside 

the Animator Controller. To do this, highlight 

the event in the timeline, and then enter the 

state name inside the Unity Inspector in the 

State Name box. For this example, we are 

going to make the avatar run, so we will enter “Run” into the State Name box. 

Previewing a Mecanim Animation 

To see how your animation looks, simply scrub the timeline with the scrub tool. You 

will now see a live preview of the animation you have applied to the character. 

Note that the animation applied to the default state inside the Animator Controller 

will begin to play automatically when you start to preview your cutscene. In this 

example, the avatar will start out idle. Then at the approx. 5 second mark, the 

avatar will begin to run at the point that even is triggered in the timeline. See Figure 

78 below. 

Figure 77: Configuring Mecanim Events 
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Figure 78: Live Mecanim Preview 

Refreshing your cutscene 

Due to the nature of how Mecanim and Unity work, you will need to refresh your 

cutscene in order to see the updates to any additional Mecanim animations you 

have added to your project, or moved to different locations in the timeline. There 

are two ways to do this. The first option is to exit preview mode. This can be done by 

clicking on the preview mode button in the Director toolbar, or by hitting the stop 

button in the Director toolbar.  

The second option is to click the refresh 

button. This can also be found on the 

director toolbar beside the cutscene 

name. Simply click this button after 

making changes to the Mecanim track 

to see live updates. 

More advanced Mecanim options 

To avoid “jumpy” transitions between Mecanim animations, it is common practice 

to create Parameters inside your Animator controller and attach them to transitions 

between states. Cinema Director allows you to access these Mecanim functions to 

run control these transitions.  

Figure 79: Live Update Button in Director 
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For example, if you want Cinema Director to control transitioning between an idle 

and run animation, but have that animation run smoothly, you would want to setup 

a Bool Parameter in the Animator Controller, and then assign that bool value to a 

transition between the Idle and Run state. See Figure 80 below: 

 

Figure 80: Setting up Bool Parameter for Transition in Animator 

Once the transition is setup the way you 

would like, you can then trigger that 

transition to happen at any time inside the 

director timeline. Click the plus icon in the 

Mecanim track and select Animator > Set 

Bool. An event keyframe will appear in the 

timeline. Click on the event and then 

change the Bool Name inside the Unity Inspector to 

match the name of the Parameter you assigned in the 

Animator. For this example, we named the parameter 

“Run Bool” and checked the “Value” box as well. This 

tells Cinema Director to trigger the animation if 

parameter value is set to “true” in the Animator 

Controller. 

Make sure to hit the Cinema Director refresh button, or 

stop, and then restart preview mode in order to see 

your changes. You will now notice a much smoother 

transition from the idle state to the run state.  

Figure 81: Selecting Set Bool Event 
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Mecanim Modes: 

There are many Mecanim functions that are built into the Animator that Cinema 

Director can control. How you use them depends on your animation needs. 

Cinema Director 

Animation Events 

 

Cross Fade 

Animator 

Create a dynamic transition from the current state to the 

new given state. Select the transition duration to determine 

how long the two animations should be cross faded for. 

Play Mecanim 

Animation 

Plays an animation by looking up the given state name. Will 

not perform any transition. 

Set Bool Set the value of a bool parameter. A Boolean is a true/false 

value, which the animator can use to perform transitions. 

Set Float Set the value of a float parameter. A float is a decimal place 

value, which the animator uses to determine things like 

speed/direction for example. 

Set Integer Set the value of an integer (whole number) parameter. 

Set Layer Weight Sets the given layers weight. This will adjust the blending of 

multiple layers, when animation playback happens. 

Set Look at 

Position 

Sets the look at position. In combination with 

SetLookAtWeight, this will direct the characters body, head, 

and eyes to look towards the given position. 

Set Trigger Set a trigger parameter in the animator to active. This is 

similar to Set Bool, except the value is returned to false on the 

next frame. 

Working with Dialogue tracks 

Dialoge tracks work the in a similar mannar as audio tracks, 

and allow you to assign audio to your character in Unity. The 

applied audio clip will default to 3D sound, and always be 

attached to the character. 

To add an audio clip, click the red plus icon in the audio 

track. You will then be promoted to select from any audio 

available in your project. You can also drag and drop audio 

from your project folder directly to the track.  

 

 

Figure 82: Adding Dialogue Clips 
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Dialogue clips can be adjusted and repositioned in the same manner as audio 

clips in Cinema Director.  

Adding additional tracks to the Character Track Group 

You can have as many dialogue tracks and 

Mecanim tracks as you wish inside of a 

Character Track Group. To add additional 

tracks, click the green plus icon beside 

the Character Track Group Name. You will then get a pulldown, prompting you to 

select either an additional Mecanim Track, or Dialogue Track. 

Copy and Paste 

You can copy and paste any item inside of the 

Cinema Director window. To copy an item, simply 

right click on that object and select “copy”. To 

paste the item to a new location, move your 

mouse to that location, right click, and then 

select “paste”.  You can also perform a copy by 

selecting copy from Unity’s “Edit” menu once you 

have an object selected. Cinema Director will 

not allow you to paste items to areas of the 

timeline that the item does not apply. For 

example, you cannot paste a Curve Clip into an 

Audio Track. 

Selecting Items 

In Director, you can select objects one at a time, 

or select multiple objects by holding down the 

CTRL key and selecting as many items as you 

wish. You can then delete all these items at once 

by hitting the delete key or right-clicking and 

selecting delete. You can also click and drag, to 

move the multiple items at one time.  

Click and hold down your mouse button on any 

empty space on the timeline to enable box 

select. Click and drag to draw a box around as 

many items as you wish, and they will all become selected.  

Figure 84: Copy and Paste Example 

Figure 83: Adding Tracks 

Figure 85: Box Select Sample 
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Working with Themes 

Setting up the Image Effect 

To further enhance the look and feel of your cutscene, Cinema Director includes 

many different themes that you can apply to cameras in your scene. These themes 

are based on Unity Pro Image effects, so 

you must be using Unity Pro for this feature. 

To work with a theme, you must first import 

the Image Effects (Pro) package into your 

current project by right clicking in your 

project folder and selecting Import Package 

> Effects. Once Imported, we will be working 

with the image effect called 

“ColorCorrectionLut”. You can find this effect 

by either typing it into the search bar for your project, or by navigating to the folder 

Standard Assets > Effects > ColorCorrectionLut. 

Next, select a camera in your scene. Once selected, click 

the Add Component button in the Unity Inspector. Do a 

search for color, and select the Color Correction (3D 

Lookup Texture). You can also add this script by navigating 

to Image Effects > Color Adjustment. The script will then be 

added to your camera Game Object. You are now ready 

to apply Cinema Director Themes to your camera. 

Applying the Cinema Director 

Theme  

Cinema Director Themes are located in 

the project folder Cinema Director > 

Prefabs > Themes > LUTs. To apply a 

theme, drag the LUT file from the LUTs 

folder to the None (Texture2D) box in 

the Unity Inspector under your selected 

Camera Game Object. For this 

example, we are using the “Horror3D16” 

theme that gives a spooky look similar to 

the movie “Sin City”. 

Figure 87: Adding Effect to 

Camera Game Object 

Figure 86: Importing Image Effects 

Figure 88: Adding a theme to the Image Effect 
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Figure 89: Example of Different Cinema Director Themes 

Figure 89 shows a few of the different themes available in Cinema Director. We 

have included eleven themes in Cinema Director that allow the user to change the 

look and mood of their cutscene. Want another 60 themes for your cameras? Then 

check out Cinema Themes, available for FREE in the Unity Asset Store! 

https://www.assetstore.unity3d.com/en/#!/content/20394 

Available Themes 

Current themes available in Cinema Director are as follows: 

- Bleach Bypass    - Noire (B&W) 

- Cross Process    - Posturize 

- Dream Sequence   - SciFi 

- FLIR     - Sepia 

- Horror     - Vintage 

- Negative 

https://www.assetstore.unity3d.com/en/#!/content/20394
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Conclusion 

 

Figure 90: Complete Timeline for this Tutorial 

Figure 90 shows a completed timeline, which covers all topics covered in the 

section Using Cinema Director. Remember that you can use the arrow icons 

on each group and each track to reorder the timeline any way you wish. You can 

also right-click any group or track name in Cinema Director and rename it. To 

maximize space on your screen, try using Cinema Director on a secondary monitor, 

and make use of the collapse arrows that are present in front of all the Group 

and Track names. This will display additional information for many track types. 

Options such as these allow you to keep your timeline organized, and will help to 

keep large projects in order. 

Cinema Director also allows advanced Unity users (developers) to create their own 

scripts for use inside the timeline. Scripts for our events libraries are not compiled, so 

you can use them as an example, and begin to build your own tools to help you 

take even more control of Unity. Visit our forums at the following link, to see our API 

documentation - http://cinema-suite.com/forum/viewtopic.php?f=25&t=170. 

Now get out there, and make an awesome cutscene! 

http://cinema-suite.com/forum/viewtopic.php?f=25&t=170
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Appendix A 
Cinema Director includes over SIXTY Track Events that can be used to control the 

Game Objects and environment inside of Unity. Below are tables that list all 

available events, their type, and a description of what they do. 

Global Track Events 

Category Name Event 

Type 

Description 

GUITexture Fade Texture Timed Performs a fade-in, display and fade 

out sequence on a given GUI Texture. 

One quarter of the time is spent fading 

in, one half displaying and the final 

quarter fading out. 

    

Cutscene Pause Cutscene Trigger Allows you to pause another cutscene 

that you have created inside the 

current project. Good for controlling in-

game sequencing while a main 

cutscene is running. 

 Play Cutscene Trigger Triggers another cutscene in your unity 

project to begin playing. 

 Stop Cutscene Trigger Stops another cutscene in your unity 

project. 

Time Time Scale Curve Timed Affects Unity’s time scale, slowing or 

speeding up the amount of time 

passing in the game. The scale value is 

affected over time by the curve 

provided. 

 Set Time Scale Trigger Affects Unity’s time scale, slowing or 

speeding up the amount of time 

passing in the game. This is useful for 

bullet time style effects. 

    

Transitions Colour Transition Timed Creates a cross fade effect between 

two custom colour selected in the Unity 

Inspector. 

 Fade From Black Timed Creates an effect that starts with a 

black screen, and fades into the 

current scene. 

 Fade From White Timed Creates an effect that starts with a 

white screen, and fades into the 

current scene. 
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 Fade To Black Timed Creates an effect that takes the current 

scene and fades it to a black screen. 

 Fade To White Timed Creates an effect that takes the current 

scene and fades it to a white screen. 

    

Utility Mass Disabler Trigger Disables multiple game objects on 

trigger by tag or selection and re-

enables them at action’s end. This is 

useful for turning off game elements 

during the sequence’s playback. 

 Load Level Trigger Will load a game level that is assigned 

to the event through the Unity 

Inspector, at the selected point in time 

on the timeline. Requires running game 

mode. 

 Storyboard Trigger Will create a screenshot in .PNG format 

that will be saved in an Assets > 

Storyboard folder of the current project. 

Requires running game mode. 

    

Audio 

Source 

Play Clip at Point Trigger Plays a one shot audio clip at a given 

point in world space. 

    

Debug Log Error Trigger Displays debug error messages in the 

editor console. Helpful for debugging 

your cutscene. 

 Log Message Trigger Displays debug log messages in the 

editor console. Helpful for debugging 

your cutscene. 

 Log Warning Trigger Displays debug warning messages in 

the editor console. Helpful for 

debugging your cutscene. 

    

Game 

Object 

Disable Game 

Object 

Trigger Makes a game object inactive in the 

current Unity Project. 

 Enable Game 

Object 

Trigger Makes a game object active in the 

current Unity Project. 

MultiActor/Actor Track Events 

Category Name Event 

Type 

Description 

Animation Play Animation Timed Plays a legacy animation on the 

actor without any blending. 
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 Blend Animation Trigger Blends the named animation with 

a target weight over the given 

time in seconds. 

 Cross Fade Animation Trigger Fades the given animation in over 

the given time in seconds. 

 Rewind Animation Trigger Rewinds the given animation. 

 Sample Animation Trigger Samples the animation at the 

current state. Good for posing 

characters. 

 Stop Animation Trigger Stops the playback of all 

animations. 

    

Animator Look At Target Timed Provide a target transform for the 

character to look at. Provide 

weights for body, head and eye 

look. 

 Cross Fade Animator Trigger Create a dynamic transition 

between the current state and 

the destination animation state. 

 Play Mecanim Animation Trigger Play a Mecanim animation by 

providing the animation state’s 

name. 

 Set Bool Trigger Sets the value of a boolean 

parameter. 

 Set Float Trigger Sets the value of a float 

parameter. 

 Set IK Position Trigger Sets the position of an IK goal. 

 Set IK Position Weight Trigger Sets the position weight of an IK 

goal. 

 Set IK Rotation Trigger Sets the rotation of an IK goal. 

 Set IK Rotation Weight Trigger Sets the rotation weight of an IK 

goal. 

 Set Interger Trigger Sets the value of an integer 

parameter. 

 Set Layer Weight Trigger Sets the animation layer’s current 

weight. 

 Set Look At Position Trigger Set a look at position, causing the 

character to look at this new point 

in space. 

 Set Look At Weight Trigger Paired with look at position, set 

the weights for the body, head 

and eye look. 
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 Set Target Trigger Sets an AvatarTarget for the 

current state. 

 Set Trigger Trigger Sets a trigger parameter to active. 

    

Audio 

Source 

Play Audio Trigger Play a given audio clip at the 

actor’s position. 

 Pause Audio Trigger Pause the playback of an audio 

clip. 

 Play One Shot Trigger Plays audio clip only once on the 

actor. 

 Stop Audio Trigger Stops the playback of audio clips 

on the actor. 

    

Game 

Object 

Disable Behaviour Trigger Disable a specified component(s) 

of the Game Object. 

 Disable Trigger Disable a Game Object that is 

currently enabled. 

 Enable Behaviour Trigger Enable a specified component(s) 

of the Game Object. 

 Enable Trigger Enable a Game Object that is 

currently disabled. 

 Send Message Trigger For advanced users. Sends 

messages between Game 

Objects. 

    

Light Set Light Colour Trigger Controls the colour of the 

selected light in the Unity Project. 

 Set Intensity Trigger Controls the intensity of the 

selected light in the Unity Project. 

    

Navigation Set Destination Trigger Sets the destination for a 

navigation component, causing 

the actor to navigate to the new 

destination. 

    

Physics Apply Force Trigger Applies a linear force to a Game 

Object using X, Y, Z coordinates. 

 Apply Torque Trigger Applies a rotational force to a 

Game Object using X, Y, Z 

coordinates. 

 Sleep Trigger Disables the updating of physics 

on a rigidbody. 
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 Wake Up Trigger Enables the updating of physics 

on a rigidbody. 

 Set Mass Trigger Apply mass to the Game Object 

 Toggle Gravity Trigger Turn Gravity for a Game Object 

on and off. 

    

Transform Attach Children Trigger Attached a given gameobject as 

a child of the actor in the scene 

hierarchy. 

 Detach Children Trigger Detaches a given gameobject as 

a child of the actor in the scene 

hierarchy. 

 Set Parent Trigger Set a new parent for the actor in 

the scene hierarchy. 

 Set Position Trigger Sets a new transformation 

position. 
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Community 
 

We want to hear from you!  Quite simply, without you, none of what we develop 

would be possible.  We always want to hear from our community, whether it is for 

feedback, sharing ideas, adding features, and providing additional help.  Here's 

how you can find us: 

 

Website:  www.cinema-suite.com 

Facebook:   /CinemaSuiteInc 

Twitter:  /CinemaSuiteInc 

YouTube:  /CinemaSuiteInc  

Blog:  www.cinema-suite.com/blog 

Email:  support@cinema-suite.com 

Forums:  www.cinema-suite.com/forum 

Help and Support 

Cinema Suite Forums: 
 

The fastest way to obtain support for Cinema Director is to visit the Cinema Suite 

forums.  Our forums can be found at www.cinema-suite.com/forum. 

Before creating a post, please make sure to search the forum using the search bar 

located in the upper right area of our forum site. 

 

If you cannot find what you are looking for, please create a new forum topic under 

the Cinema Director category "Help and Support" by clicking on the text below. 

 

http://www.cinema-suite.com/
http://www.facebook.com/cinemasuiteinc
http://www.twitter.com/cinemasuiteinc
http://www.youtube.com/cinemasuiteinc
http://www.cinema-suite.com/blog
mailto:support@cinema-suite.com
http://www.cinema-suite.com/forum
http://www.cinema-suite.com/forum
http://www.facebook.com/cinemasuiteinc
http://www.twitter.com/cinemasuiteinc
http://www.youtube.com/cinemasuiteinc
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Once inside the Help and Support area for Cinema Director, create a new topic by 

selecting the new topic button in the upper left area of the page. 

 

We constantly monitor our forums for new support inquiries.  

Email: 
If you fail to receive an answer in the forums, you may also email our support team 

directly.  Our email address is support@cinema-suite.com. 

Please note the following when emailing support for quickest service: 

1. We need 2-3 days to process email support requests, due to volume. 

2. For fastest service, please provide your Unity Asset Store Purchase invoice 

number for our product. 

3. Put invoice number in subject field, with brief description of problem. 

4. In the body of the email, please provide as much of the following as possible, for 

quickest service: 

 Detailed explanation of the problem. Provide screenshots if possible. 

 What version of Unity? 

 What version of Cinema Director? (Go to Window>Cinema Suite>About 

to obtain version number). 

 Sequence of events leading to issue. 

Licensing: 
Licensing for Cinema Director is governed by the Unity Asset Store End User License 

Agreement (EULA). For more information about the EULA, please click here for more 

information. 

  

mailto:support@cinema-suite.com
http://unity3d.com/company/legal/as_terms
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Thank you 
 

Without you, what we do would not be possible.  We sincerely thank you for 

purchasing Cinema Director, and allowing us to create software that helps the 

community do their work quicker, easier, and hopefully with a bit more fun. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Cinema Suite Inc. would like to extend a special thank you to the Canada Media Fund 

for making Cinema Director possible. 
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